MATLAB Simulation to Determine Optimal Design of Thin Films with Embedded Nanoparticles for Optical Heating Applications

A Thesis

Presented to

The Honors Tutorial College

Ohio University

In Partial Fulfillment

of the Requirements for Graduation

with the degree of

Bachelor of Science in Chemistry

by

Julie Bodette

April 2018
This thesis has been approved by

The Honors Tutorial College and the Department of Chemistry

____________________________________

Dr. Hugh Richardson

Professor, Chemistry

Thesis Advisor

____________________________________

Dr. Lauren McMills

Director of Studies, Chemistry

Thesis Advisor

____________________________________

Cary Frith

Dean, Honors Tutorial College
Table of Contents

Abstract........................................................................................................................................6

Introduction

Applications...................................................................................................................................7

Theory...........................................................................................................................................10

Objective.......................................................................................................................................11

Methods

Reproduction of Baffou’s Work......................................................................................................12

Acquiring Previously Known Data and Importing into MATLAB.............................................12

Calculate Absorbance Spectra Under Sunlight..........................................................................13

Calculation of Temperature Increase for 1 Nanoparticle..............................................................15

Calculation of Temperature Increase for Entire Sample Full of Nanoparticles.........................15

Calculation of Interparticle Distance.............................................................................................17

Correction for Intensity Decrease Through Sample.....................................................................19

Fabrication and Characterization of Sample..................................................................................20

Simulation of Sample.......................................................................................................................30

Calibration of Solar Simulator.........................................................................................................30
Code Optimization.............................................................................................................33

Optimization Procedure for Samples.................................................................................34

Results

Simulated Absorbance Data...............................................................................................34

Temperature Generation Comparison Between Experimental and Theoretical..............39

Sample Simulation Results................................................................................................40

Calibration Results.............................................................................................................41

Optimization Results..........................................................................................................42

  Radius.............................................................................................................................42

  Thermal Conductivity of Medium.................................................................................44

  Nanoparticle Material.................................................................................................45

  Mass..............................................................................................................................48

Discussion

Interparticle Distance.........................................................................................................49

Size Distribution.................................................................................................................51

Radius..............................................................................................................................52

Thickness..........................................................................................................................53

Conclusion.........................................................................................................................54
Appendix

Appendix A: Reproduction of Baffou’s work

Appendix B: Code to plot Absorbance vs Wavelength

Appendix C: Read the solar intensity at a given wavelength from a data file.

Appendix D: Calculate the temperature increase for 1 nanoparticle

Appendix E: This function takes interparticle distance and number of particles and returns the expected temperature change under one sun.

Appendix F: This function converts concentration (in g solute /mL solvent) to interparticle distance and number of particles.

Appendix G: Code corrects for the exponential decrease in intensity as you go further through the sample.
Abstract

Optical heating has numerous applications, such as cold weather clothing, heat generation for homes, and solar thermal generation of electricity. One form of this optical heating technology is the fabrication of poly (methyl methacrylate) polymer thin films with embedded nanoparticles, such as titanium nitride and carbon black. MATLAB was used to simulate samples, in order to determine the optimal configuration for most heat generated. The optimal configuration was carbon black nanoparticles with a radius of 900nm, packed closely together (1800 nm apart), in a medium such as aerogel with low thermal conductivity, with a maximum mass of carbon black and minimal thickness of the sample.
Introduction

I. Applications

One potential application of a nanoparticle-embedded film is that of cold weather clothing for use in extreme environments such as Antarctica. The limits of human endurance are reached at temperatures of -50 to -60 degrees Fahrenheit. At these temperatures, if excessive amounts of exercise are done (enough to cause deep breathing), the lungs may rupture and bleed. Warm clothing is essential to stop the onset of hypothermia and eventual death. Several factors must be taken into account when creating such clothing, for example, the thermal conductivity of the fabric and the ability of the fabric to wick away moisture from sweat. One potential application for an optical heating nanoparticle embedded polymer-based material would be as that of a windbreaker. Warm fabrics that are not dense are generally used to keep heat in, but they do not protect from heat loss from excessive amounts of wind. An ideal windbreaker is dense enough to prevent most air from passing through it, though still able to release water vapor to the atmosphere. This has typically been achieved by a thin, lightweight fabric, which cannot keep the body warm; its only purpose is to shield the body from wind. A nanoparticle-embedded fabric or plastic sheet that produces warmth when hit by sunlight could achieve a dual purpose; it could generate heat to keep the human body warm, while also protecting from wind. This could reduce the overall weight of fabric required for an explorer in extreme environments. Though the data in the experiments referenced here were done in Antarctica, explorers in extreme environments such as Mars could also use such clothing technology. If an expedition to the polar cap of Mars was done in polar summer, there would be temperatures of around -125 degrees
Celsius\textsuperscript{2}. However, there would also be constant sunlight (no nights)\textsuperscript{2}. This would make a nanoparticle-embedded fabric or plastic sheet that produces warmth when hit by sunlight very useful; it could be used all the time, instead of being useless at night due to the lack of sunlight.

Another application of optical heating is to help solve the problem of global warming. Global warming, caused by human carbon emissions, is a serious problem that cannot be solved by the choices of one person or company working alone. The IPCC (Intergovernmental Panel on Climate Change) assess many factors (social, economic, and technological) contributing to attempts to decrease emissions and halt the spread of global warming\textsuperscript{3}.

A report from the IPCC noted that demand for energy is increasing, and although the current system uses mostly fossil fuels, the number of renewable energy power plants is growing\textsuperscript{3}. And although renewable energy costs tend to be higher than fossil fuels, renewable energy costs are decreasing. More technological progress, resulting from more research, is needed to further lower costs.

A 2009 meta-analysis found that renewable energy fields (biomass, geothermal, solar photovoltaics, solar thermal, wind) generate more jobs per unit energy produced than non-renewable energy such as fossil fuels and natural gas\textsuperscript{4}. Of these renewable energies, solar photovoltaics create the most jobs per unit energy produced, with solar thermal and geothermal being the second most. The jobs created were measured in units of person-years (one year of full-time employment for 1 person) per GWh. Solar photovoltaics create 0.87 person-years/GWh of jobs, while geothermal creates 0.25 person-years/GWh of jobs and solar thermal 0.23 person-years/GWh of jobs\textsuperscript{4}. It is clear that the implementation of these technologies, as they already are, has great potential to produce jobs. Further research into these technologies can increase
their efficiencies, encouraging more companies to adopt these energy types, and reducing energy costs.

Regular solar panels are a well-known source of renewable energy. However, most have surprisingly low efficiency, ranging between 17.5-38.9% efficiency\(^4\). In comparison, the efficiency of solar thermal heating is much higher. Normally, the efficiency falls around 40-60% for steam generation, though over 90% efficiency has been achieved\(^4\). The difference between regular solar panels and solar thermal technology is simple. Solar panels rely on converting sunlight directly into electricity. Solar thermal devices use sunlight to heat water and can either use the hot water directly, as the desired end result or use the steam to then produce electricity. Previous solar thermal devices required the use of expensive optical lenses to concentrate the light enough to boil water. The ability to do this at one sun greatly reduces the cost of the technology; Optical lenses cost around $4,500-$7,150 per kW\(^5\).

A previous study by Gang Chen et al. highlights the potential of solar thermal energy capturing techniques\(^6\). They were able to achieve a temperature of 100 degrees Celsius, enough to boil water, at a solar concentration of only one sun (regular sunlight). A selective absorber, that is, a material which absorbs large amounts of light but emits small amounts of heat, enabled them to achieve these incredible results. The selective absorber in question used in their experiment was BlueTec eta plus, a commercially available material, coated on a copper sheet. Their setup consisted of a bulk solution of water, with foam placed on top. The selective absorber was placed on top of the foam, and bubble wrap was placed on top of the selective absorber. A wick was used to slowly draw water up to the selective absorber, where the selective absorber then transferred heat to the water, causing it to evaporate\(^6\).
A similar application to solar thermal energy for electricity is that of desalination. Essentially, instead of using the water boiled by solar thermal heating as steam to power an engine and produce electricity, salt water can be boiled and later collected. This is essential in many areas of the world where people need freshwater. An estimated 660 million people do not have access to clean drinking water\(^5\). Additionally, over 80% of countries do not have enough money to meet WASH drinking water and sanitation targets, so a low-cost solution is necessary\(^5\).

II. Theory

Metallic nanoparticles are very, very small, on the scale of nanometers. A nanometer is a billionth of a meter. For reference, a human cell has a diameter of around 100,000 nanometers. Due to their incredibly small size, nanoparticles have special properties. For example, the smaller an object, the fewer chances it has to develop imperfections. So, nanoparticles tend to be very strong, because there are no “weak points” from imperfections\(^5\). (This is why, for example, carbon nanotubes are so strong.) Nanoparticles also have a very large surface area: volume ratio, which decreases their reaction time.

Previous studies have shown that gold nanoparticles can absorb visible and IR light and convert it to heat. (This has applications, for example, in the field of cancer treatment, where gold nanoparticles can be injected into a tumor, and then heat up when an IR laser is shined on them, lysing the tumor.) TiN nanoparticles absorb light in similar regions of the spectrum as gold does. In fact, TiN nanoparticles are more efficient than gold nanoparticles! 80 nm TiN particles absorb the same amount of light as a gold nanoshell with an inner diameter of 110 nm and an outer diameter of 130 nm\(^5\). Their volume is 2.25 times less, and their area is 2.07 times
smaller than the aforementioned gold nanoshell, thus making them more efficient because they absorb the same amount of light\textsuperscript{5}.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{solar_spectrum.png}
\caption{Extraterrestrial Solar Spectrum and That Received at Ground Surface for Air Mass 1.5, H\textsubscript{2}O 2 cm, O\textsubscript{3} 0.34 cm and $\alpha = 0.66, \beta = 0.085$}
\end{figure}

Shown above is the solar spectrum- the wavelengths at which the sun emits light\textsuperscript{5}. The top graph is the raw blackbody radiation data (the wavelengths that the sun emits). The bottom graph takes into account the wavelengths of light and their intensities that remain after the sunlight passes through the atmosphere. An optimal absorber will absorb light at as many of these wavelengths as possible.

\section*{III. Objective}

Computer simulations involve finding a model that describes a process, implementing that model in a program, using the program to calculate the results, and drawing conclusions from those results \textsuperscript{7}. They are extremely useful as an alternative to empirical experiments that
are tedious or even impossible to run. Although they do not always perfectly mimic empirical results, they are a very useful scientific tool for understanding complex systems. In this paper, I simulate titanium nitride (TiN), graphite, and gold nanoparticles under sunlight in varying conditions. I then determine the optimal specifications of a thin film of nanoparticles that will produce the most heat (measured by the greatest average temperature achieved) under sunlight.

Previous work done in the field of simulating nanoparticle thermodynamics used the optical constants of gold nanoparticles to model absorption cross-section and the thermal effects after a gold NP was hit with a laser\(^8\). My work builds upon Baffou’s code, applying similar scenarios to TiN and carbon black NP thin films. All code in this project was done in MATLAB.

The main difficulty with writing code was that I cannot store the units along with my values, and I must keep track of them in my head, or, preferably, with comments. I made sure to comment my code well so that a future user can understand it. All lines of code that begin with \(\%\) are comments. This means that they are not evaluated by the computer as commands to run, and are only useful as notes to a human reading the code. I also chose variable names that were intuitive (ie, indexOfRefraction instead of variable1, or even particle_distance_in_nm instead of distance).

Methods

Reproduction of Baffou’s Work\(^8\)

I began by reproducing some of the figures from Baffou’s paper, as a way to teach myself MATLAB and get used to the types of programs I would be writing. See Appendix A.

Acquiring Previously Known Data and Importing into MATLAB
Data on the optical constants of TiN and carbon black were acquired from the cited sources. Essentially, my goal was to produce a text file with the energy of the wave in eV and the optical constants n and k. I needed two files identical in structure to nAu.txt but with eV, n, and k for TiN and carbon black. I imported the data in excel and converted the wavelength in um to energy in eV. That is the units that Baffou’s program takes, which is why it needed to be changed. However, the file would not load. Baffou’s program did not accept the formatting of my file. The solution was to make the file in Excel, save it as a .csv file, and then rename it so it was a .txt file.

Data of solar irradiance was taken from The RreDc (Renewable Resource data center) of NREL (National Renewable Energy Laboratory) website.

![ASTM G173-03 Reference Spectra](image)

**Figure 2: Solar Irradiance vs Wavelength.** See Appendix C for the code that was used to read the solar intensity at a given wavelength from a data file.
Figure 3: Comparison of TiN absorbance and sunlight intensity at varying wavelengths

Figure 3 shows the absorbance spectra of a 250 nm TiN nanoparticle over a graph of sunlight intensity. Note that the peak absorbance of TiN roughly correlates to the peak intensity of sunlight.

Calculate Absorbance Spectra Under Sunlight

The absorbance spectra were calculated using the program MieScattering, created by Baffou. Once the absorbance spectra were determined, the next step was to calculate the absorbance spectra under sunlight. Essentially, in the previous graphs, an equal intensity of light from each wavelength was assumed. With the solar irradiance data, the actual intensity of light from each wavelength was known and could be accounted for.

Calculation of Temperature Increase for 1 Nanoparticle
After the intensity was read, the total delta $T$ (temperature increase in Kelvin) was calculated for a single nanoparticle (See Appendix D for code).

The equation used was:

$$\Delta T = \frac{\sigma(\lambda)I(x)}{4\pi k R}$$  \hspace{1cm} (1)

Where is the $\Delta T$ is the temperature change in degrees Kelvin, $\sigma (\lambda)$ is the absorbance cross section in square meters, which varies as wavelength ($\lambda$) varies, $I(x)$ is the intensity in Watts per square meter, which decreases throughout the sample, $k$ is the thermal conductivity of the material that the nanoparticle is in, in Watts per meter-Kelvin, and $R$ is the radius of the nanoparticle in meters. Note that because this simulation only had one nanoparticle, the effect of distance through the sample on intensity could be ignored, because the sample thickness was negligible.

The temperature increase from the light from each wavelength was graphed. The graph was integrated in order to determine the total temperature increase.

### Calculation of Temperature Increase for Entire Sample Full of Nanoparticles

After one nanoparticle under sunlight was simulated, multiple nanoparticles were simulated. However, the amount of heat generated does not scale linearly with the number of nanoparticles. The following equation was used to determine how the heat scaled: \textsuperscript{13}
\[ \Delta T_{\text{total}} = \frac{\Delta T_{\text{NP}} \ast R \ast N_{\text{NP}}^{\frac{m-1}{m}}}{d} \]  

(1)

Where \( \Delta T_{\text{total}} \) is the total change in temperature in Kelvin, \( \Delta T_{\text{NP}} \) is the temperature increase for a single nanoparticle, \( R \) is the radius of the nanoparticle in nanometers, \( d \) is the distance between particles in nanometers, and \( m \) is the number of dimensions (2 for a 2D system or 3 for a 3D system). See Appendix E for the code that uses this equation to scale up the number of nanoparticles.

**Calculation of Interparticle Distance**

Generally, experiments are run where the concentration of nanoparticles is known, but not the distance between particles. In order to compare the theoretical results from the program to the experimental data, the code was written that took into account the volume of solution, the mass of particles and output the distance between particles in nm. (See Appendix F)

The sample was assumed to consist of evenly spaced spherical particles with identical radii. As seen in Figure 4, each particle resides in a cube with dimensions \( D \ast D \ast D \) and volume \( D^3 \). \( D \) is equal to the length of one of the sides of the box, as well as the interparticle distance.
Figure 4: Visualization of the simulated sample. D is the interparticle distance in nm

The radius of the particle, which was given in nm was converted to cm. Then the volume of one spherical particle in cm$^3$ was found using the equation for the volume of a sphere:

\[ V = \frac{4}{3} \pi r^3 \]  

(2)

Where $V$ is the volume of one nanoparticle in cm$^3$ and $r$ is the radius in centimeters.

The mass of one nanoparticle was found through the following equation:
\[ M_{NP} = \rho V \]  

Where \( M_{NP} \) is the mass of one nanoparticle in grams, \( \rho \) is the density in g/cm\(^3\) of the material that the nanoparticle is made of (For example, 5.4 g/cm\(^3\) for TiN), and \( V \) is the volume in cm\(^3\) of one nanoparticle.

The number of nanoparticles in the sample was found through the following equation:

\[ T_{NP} = \frac{M_T}{M_{NP}} \]  

Where \( T_{NP} \) is the total number of nanoparticles, \( M_T \) is the total mass of the nanoparticle material in the sample in grams (For example, the total mass of TiN in the sample. Note that this is NOT the total mass of the sample) and \( M_{NP} \) is the mass of one nanoparticle in grams.

**Correction for Intensity Decrease Through Sample**

Next, I corrected for the amount of light that actually reaches the TiN as it travels further into the sample. Intensity falls off exponentially as light passes through the sample, according to the following equation:
\[ I(x) = I_0 e^{-A nx} \quad (5) \]

Where \( x \) is the distance into the sample, \( I(x) \) is the intensity of light at distance \( x \), \( e \) is the mathematical constant equal to 2.718, \( A \) is the absorbance cross-section in \( \text{nm}^2 \), and \( n \) is the surface concentration in particles/\( \text{nm}^2 \). See Appendix G for the code.

Once the \( x \) dependence was taken into account, the equation for the temperature of a single nanoparticle became:

\[ \Delta T = \frac{\sigma(\lambda) I(x)}{4\pi k R} \quad (6) \]

Where \( \Delta T \) is the temperature change in degrees Kelvin, \( \sigma (\lambda) \) is the absorbance cross section in square meters, which varies as wavelength (\( \lambda \)) varies, \( I \) is the intensity in Watts per square meter which is a function of \( x \), \( k \) is the thermal conductivity of the material that the nanoparticle is in, in Watts per meter-Kelvin, and \( R \) is the radius of the nanoparticle in meters.

**Fabrication and Characterization of Sample**
Figure 5: TiN particles under SEM

Figure 5 shows TiN nanoparticles under SEM. Pictures of the TiN particles were taken under SEM by Dr. Kordesch. These pictures show that the particle size clearly has a great range; the particles are not of uniform size.
Figure 6 shows pictures of the TiN sample under the NSOM microscope. Note that there is a huge variation in particle size, as well as particle distribution. See Figure 7 for the particle size analysis histograms for the images in Figure 6.

Pictures of the sample were taken in brightfield. The pictures were analyzed in ImageJ to determine the size and density of the particles.

The procedure for ImageJ analysis was as follows:

1. File -> Open and choose the image from the computer
To set the scale:

2. Choose the line tool, which looks like this:

3. Draw a line across the scale bar

4. Analyze -> Measure. The length of the line in pixels will appear in the “Results” box.

5. Analyze -> Set Scale. Set the distance in pixels to the length that you just measured. Set the known distance to the scale bar length (30 um in this case). Set the unit of length to the correct units (um in this case).

6. (Optional) You can also check “Global” if you will be opening multiple images with the same scale.

To determine the number and size of particles in the picture:

7. Edit -> Options -> Conversions “Scale when Converting”

8. Convert to grayscale by doing Image -> Type -> 16-bit

9. (Optional) Process -> Subtract Background (This can help reduce noise)

10. Adjust the threshold by doing Image -> Adjust -> Threshold. Drag the bar so that the maximum amount of particles can be seen, without too much extra noise and hit “Apply”

11. Analyze -> Analyze Particles. Check the following boxes: Display results, Summarize.
    Uncheck the box: Clear Results

12. On the results window that pops up, click File -> Save As and save the results in a text file.

Note that the scale is 5.2916 pixels/um.

Each picture of the sample was analyzed in ImageJ, and the area in um² was recorded for each particle. The area was converted to the radius in nanometers through the following equation:
\[ r = \sqrt{1000A\pi} \]  

(7)

Where \( r \) is the radius in nanometers and \( A \) is the area in \( \text{um}^2 \).

A histogram was made of the radius in nm for each picture, with bins every 200 nm from 200 nm to 3200 nm.
Figure 7: Size Distribution of particles for images A-D

Figure 7 shows the particle radius distribution in nm for the images in parts A-D of Figure 6. Note that it does not follow a standard distribution. A uniform distribution of particle sizes throughout the sample was not achieved, as can be further seen in Figure 8.

<table>
<thead>
<tr>
<th>Average radius</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
As seen in Figure 8, the average radius and standard deviation vary between different parts of the sample. Picture C in Figure 6 has the biggest standard deviation of particle size in all the pictures. Taking all four pictures of the sample into account, the average radius is 914 nm with a standard deviation of 1207 nm. Based on this data, a uniform particle distribution is difficult to achieve.

The procedure for sample fabrication is as follows:

A solution of .5 mL of approximately 4 wt% PMMA in anisole and .0938g TiN was created. 70 uL of that solution was spin-coated onto a glass slide at 1000 rpm for 60 seconds. A thermocouple was glued to the sample with Hard as Nails glue, and the end was taped down to further prevent from sliding off. With a thermocouple attached, the temperature could be measured by the solar simulator.

<table>
<thead>
<tr>
<th></th>
<th>(nm)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>932</td>
<td>835</td>
</tr>
<tr>
<td>B</td>
<td>866</td>
<td>898</td>
</tr>
<tr>
<td>C</td>
<td>920</td>
<td>2212</td>
</tr>
<tr>
<td>D</td>
<td>924</td>
<td>873</td>
</tr>
</tbody>
</table>
Figure 9 shows the TiN thin film sample. Part A shows the thermocouple taped to the sample, and that part of the sample was on top of the tape, which was peeled off so that the thickness could be measured. The thickness was 22.3 µm +/- 3.6 µm. On Part B, note the large amount of particle non-uniformity in the sample. Certain parts of the sample are darker than others, due to a higher concentration of TiN. The darkest part (highest concentration of TiN) is the black dot on Part B. This is where the thermocouple was glued to the sample. Some of the PMMA may have dissolved here.

The following procedure was used to measure the thickness of the sample:

The sample was brought into focus, the height of z-axis in um was set to zero. Then the glass slide was brought into focus, and the new z-axis height was noted. This procedure was repeated several times to get a more accurate reading.
Figure 10: Percent transmittance vs wavelength for TiN sample

Figure 10 shows the percent transmittance of light through the TiN sample at varying wavelengths. The procedure that resulted in this data is as follows: The TiN sample was placed in the OceanOptics UV-Vis spectrometer. After a clean glass slide was used as a blank, the sample was placed in the instrument. The percentage of light that was transmitted through the sample was measured.

Absorbance and percent transmittance are related through the following equations:

\[
T = \frac{I}{I_0} \tag{8}
\]

\[
A = -\log_{10}\left(\frac{I}{I_0}\right) \tag{9}
\]
Where A is absorbance, T is percent transmittance, $I_0$ is the intensity at the top of the sample (before the light gets attenuated), and I is the intensity at the point in the sample that you are looking at.

The intensity of light decreases exponentially, the farther you move through the sample, according to the following equation:

$$\frac{I}{I_0} = e^{-abc} \quad (10)$$

Where $I/I_0$ is normalized intensity, $e$ is the mathematical constant 2.718, $a$ is the absorptivity constant in L/mol/cm, $b$ is the path length in cm, and $c$ is the concentration in mol/L.

Our data showed approximately 10% transmittance—that is, only 10% of the light passed through the sample. This means that $I/I_0$, or normalized intensity, is equal to 0.1. We know our sample thickness is 22.3 +/- 3.6 um. This information was then used to produce a simulation of the sample, as shown in Figure 11.
Figure 11: Simulation of intensity decrease throughout TiN sample

Figure 11 shows the exponential decrease in normalized intensity as light moves through the sample. This is the same exponential trend that results from (10). If we simulate the correct radius of the particles at the same thickness of material we get the same % transmittance of light. Figure 11 shows the simulation that resulted in a 10% transmittance, which used 250 nm radius particles. This shows that our particle radius is about 250 nm. More simulations were run with varying sizes of particles, with a 25.9 um thick sample and an 18.7 um thick sample, to find the error in particle radius size.

Particle radius was found to be 250 +/- 40 nm. Because this had a much smaller uncertainty than the radius calculated from the sample pictures, this number was used in simulations. Note that this is different from the value that the box that the TiN particles came in gave. The box said that they had an average radius of 400 nm.
In order to find out how hot the sample would get under sunlight, the sample was placed under a solar simulator, and the temperature increase after the solar simulator was turned on was measured. The sample was compared to a blank of a glass slide. Additionally, multiple temperature measurements were taken by a probe thermometer to determine the temperature change.

**Simulation of Sample**

The following functions with these arguments were used:

getLotsOfAbsorbanceData(radiusInNm, indexOfRefraction, LoadFileName, SaveAsFileName)

FindTemperatureAsAFunctionofDistance(mass, density, volumeOfSolutionmL, matrixFile, thermalConductivity, thicknessInCm, SaveAsFileName)

See Appendix for code.

**Calibration of Solar Simulator**

A calibration was done to determine the height that the sample had to be placed at in order to receive one sun (approx. 1000 W/m²) of light.
Figure 12 shows the experimental setup used to calibrate the number of suns that were hitting the sample. The light source, which comes from the solar simulator, is at the top. The power meter, which was used to measure the power of light that hit the sample at different distances, was below the light source. X cm is the distance between the power meter and the light source, which varied. Long distances were created by placing the power meter on top of a stack of paper towels. Shorter distances were created by placing the power meter on top of an adjustable jack. The shorter the distance, the closer the sample was to the light source, and therefore the higher the intensity.
The power measured by the power meter was measured at varying heights of $x$ cm, and recorded in the following table:

<table>
<thead>
<tr>
<th>Power (mW)</th>
<th>Sun</th>
<th>Distance from the light source ($x$)</th>
</tr>
</thead>
<tbody>
<tr>
<td>214</td>
<td>1.06</td>
<td>19.9</td>
</tr>
<tr>
<td>428</td>
<td>2.13</td>
<td>12.3</td>
</tr>
<tr>
<td>505</td>
<td>2.51</td>
<td>11</td>
</tr>
<tr>
<td>601</td>
<td>2.99</td>
<td>9.5</td>
</tr>
<tr>
<td>703</td>
<td>3.5</td>
<td>8.65</td>
</tr>
<tr>
<td>804</td>
<td>4</td>
<td>7.7</td>
</tr>
<tr>
<td>901</td>
<td>4.48</td>
<td>6.8</td>
</tr>
<tr>
<td>1000</td>
<td>4.98</td>
<td>6.15</td>
</tr>
<tr>
<td>1100</td>
<td>5.47</td>
<td>5.6</td>
</tr>
<tr>
<td>1200</td>
<td>5.97</td>
<td>5</td>
</tr>
<tr>
<td>1300</td>
<td>6.47</td>
<td>4.4</td>
</tr>
<tr>
<td>1410</td>
<td>7.01</td>
<td>4</td>
</tr>
<tr>
<td>1500</td>
<td>7.46</td>
<td>3.6</td>
</tr>
<tr>
<td>1600</td>
<td>7.96</td>
<td>3.3</td>
</tr>
<tr>
<td>1700</td>
<td>8.46</td>
<td>3</td>
</tr>
<tr>
<td>1800</td>
<td>8.96</td>
<td>2.5</td>
</tr>
<tr>
<td>1900</td>
<td>9.45</td>
<td>2.1</td>
</tr>
<tr>
<td>2010</td>
<td>10</td>
<td>1.8</td>
</tr>
</tbody>
</table>
Figure 13 shows the power, converted into suns, measured at varying sample heights. The calculations that resulted in this table are as follows:

The height of the power meter was 3.5 cm, and the radius of the power meter’s circular sensor was 0.8 cm. Area = 3.14*radius², so the area of the power meter’s sensor was 2.011 cm².

One sun, or 1000W/m² was converted into W/cm²:

\[
\frac{1000 W}{1 m^2} \cdot \frac{1 m}{100 cm} \cdot \frac{1 m}{100 cm} = \frac{1000 W}{10,000 cm^2} = .1 W/cm^2
\]  

Then the number of watts of light hitting the power meter that indicated an intensity of one sun was calculated:

\[
\frac{.1 W}{1 cm^2} = \frac{X W}{2.011 cm^2}
\]  

The result of this calculation was that 0.201 W or 201 mW on the power meter is equal to an intensity of 1 sun.

**Code Optimization**
The code was optimized. It was put all in 3 files, GetLotsOfAbsorbanceData(), CalculateDeltaT(), and FindTemperatureasaFunctionofDistance(). GetLotsOfAbsorbanceData() generates absorbance data for a certain type of nanoparticle, with a specified radius, in a certain medium. That data is stored in a .mat file. CalculateDeltaT() uses that .mat file to calculate the expected temperature increase if a sample made from the material was put under sunlight. Finally, FindTemperatureasaFunctionofDistance() calls CalculateDeltaT() multiple times, in order to take into account the decrease in intensity of light as you move further into the sample.

**Optimization Procedure for samples**

Several factors were optimized: radius, nanoparticle material, mediums, concentration, and thickness. The program was run with different values for each parameter, and the parameters that resulted in the highest temperature change were noted.

**Results**

**Simulated Absorbance Data**
Figure 14: Simulation of the absorbance of 25 nm radius TiN compared to experimental data with varying wavelength. See Appendix B for the code. Credit: Zach Blumer for the experimental data

Figure 14 shows the absorbance cross-section of TiN in water with varying wavelength. It shows simulated data generated in MATLAB and experimental data of a UV-Vis spectrum of a 25 nm TiN particle. A peak in the theoretical absorbance can be seen at 524 nm, whereas the experimental absorbance has a peak at 701 nm. The theoretical absorbance does not match up perfectly with the experimental absorbance. This is likely due to a range of particle sizes in the experimental data caused by agglomeration. As seen in Figure 16, the absorbance band shifts as the particle size changes. Additionally, the theoretical data is blue-shifted compared to the experimental.
Figure 15: Simulation of the absorbance cross-section of TiN with a varying radius. See Appendix B for the code.

Figure 15 shows a simulation of the absorbance cross-section of TiN in water at a constant wavelength of 532 nm, but with a varying radius of particles. As the radius increases, the absorbance cross-section increases.
Figure 16: Simulations of absorbance cross-section at varying particle radii for TiN. See Appendix B for the code.

Figure 16 shows the absorbance cross-section of TiN in water at varying wavelengths with particle radii of 10 nm - 100 nm. Note that there is a shift in the wavelength of maximal absorbance, as well as an increase in absorbance cross-section with radius. This graph was simulated with a single nanoparticle of TiN in PMMA.
Figure 17: Simulations of absorbance cross section at varying particle sizes for Graphite. See Appendix B for the code.

Figure 17 shows the absorbance cross-section of graphite in water at varying wavelengths with particle radii of 10 nm - 100 nm. Note that just like with the TiN, there is a shift in the wavelength of maximal absorbance, as well as an increase in absorbance cross-section with an increase in radius. This graph was simulated with a single nanoparticle of carbon (graphite) in PMMA.
Figure 18: Fit of Cross Section vs radius

Figure 18 shows a comparison between the MATLAB simulation data of cross section vs radius and the curve fitted to the data when trying to determine the trend. It fits somewhat closely to an exponential ($x^2$) trend. Baffou showed a similar trend for gold nanoparticles.  

The equation for Line of best fit is: \( \text{AbsorbanceCrossSection} = \text{Radius}^2 \times 1.15 \)

As seen in Figure 18, the fit doesn’t work perfectly. The difference between cross-section calculated from this fit and excel cross section was measured. When the absorbance cross-section simulated in MATLAB was $1.50 \times 10^5$ nm$^2$, the fitted absorbance cross section was $5.0 \times 10^4$ nm$^2$, for a difference of $9.95 \times 10^4$.

Temperature Generation Comparison Between Experimental and Theoretical
Figure 19 shows the temperature change at various intensities of light for the TiN sample and the simulation. Note that the temperature change increases linearly with an increase of suns, with the equation \( y = 1.8816x + 5.7525 \), where \( y \) is the temperature change in degrees Celsius, and \( x \) is the intensity of light in suns.

Note that the simulation in this graph was run using sunlight with no absorbance from the atmosphere, because the solar simulator does not have much atmospheric interference between it and the sample, unlike actual sunlight.

**Sample Simulation Results**
Figure 20 shows the simulation results for the sample. A 250 nm radius of TiN particles in PMMA in 0.07 mL solution was simulated. The mass was 0.0314 g of TiN particles and the thickness of the sample was 22 µm. The average temperature measured was 1.2287 °C.

Calibration Results
Figure 21: Calibration Plot of Intensity vs Height

Figure 21 shows the calibration plot that was created from the data in Figure 13. The equation for the line of best fit for the calibration plot of intensity vs height was found to be $y = 21.405e^{-0.244x}$, where $y$ is intensity in Suns and $x$ is sample distance from the light source in cm. This equation can be used to determine the intensity of light at any distance above the table.

Optimization results

Radius
Figure 22: Varying mediums

<table>
<thead>
<tr>
<th>Medium</th>
<th>Average Temp</th>
<th>Thermal Conductivity (W/m*K)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aerogel</td>
<td>14.7694</td>
<td>0.017</td>
</tr>
<tr>
<td>amorphous AlN</td>
<td>0.1806</td>
<td>1.5</td>
</tr>
<tr>
<td>PMMA</td>
<td>1.2287</td>
<td>0.209</td>
</tr>
</tbody>
</table>

Figure 22 shows a simulation of 250 nm radius TiN particles in 0.07 mL solution. The simulated mass is kept constant at 0.0314 g of TiN particles and the thickness of the sample is
kept constant at 22 µm. Note that aerogel results in a much higher temperature change than amorphous AlN or PMMA. This effect is explored further in Figure 23.

**Thermal Conductivity of Medium**

![Graph](image)

*Figure 23: Effect of Thermal Conductivity of Medium on Average Temperature Increase*

As shown in Figure 23, as the thermal conductivity of the medium increases, the average temperature generated by the sample decreases exponentially.
Figure 24 shows that thermal conductivity of the medium and average temperature generated can be related through the following equation:

\[ y = 3.6953x \]  

(13)

Where \( y \) is 1/average temperature and \( x \) is thermal conductivity. Figure 24 shows the same effect as Figure 23, just with a different equation.

This happens because in materials with a lower thermal conductivity, the heat generated by the particles stays near them and does not dissipate away. In materials with a high thermal conductivity, the heat produced by the particles quickly dissipates through the sample.

Nanoparticle Material
As shown in Figure 25, Graphite generates the highest temperature at the surface, followed by TiN, and then gold. This occurs because graphite is black- it absorbs at all wavelengths. TiN is second-best, as it is brown and absorbs in quite a few wavelengths as well.
Gold, however, is yellow, and has absorbance gaps in the visible range; it reflects yellow light. Note that graphite has a smaller optimal thickness of sample than TiN. This effect is due to the graphite particles in the first five micrometers of the sample absorbing more light, preventing the graphite particles below them from getting enough light to generate a significant amount of heat. In titanium nitride, this same effect occurs at a thickness of twelve micrometers. Note that these distances are dependent on the radius of the particles- in this case, the radius is 250 nm.

<table>
<thead>
<tr>
<th></th>
<th>cost per gram (USD)</th>
<th>Surface Heat generated per dollar (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gold</td>
<td>43.36</td>
<td>0.013132</td>
</tr>
<tr>
<td>TiN</td>
<td>0.05</td>
<td>24.574</td>
</tr>
<tr>
<td>Graphite</td>
<td>0.5</td>
<td>2.3494</td>
</tr>
<tr>
<td>Carbon Black</td>
<td>.0011</td>
<td>18082</td>
</tr>
</tbody>
</table>

*Figure 26: Cost comparison of Gold, TiN, Graphite, and Carbon Black*

As shown in Figure 26, carbon black has the highest amount of degrees Celsius generated per dollar, due to its low cost and high surface temperature. TiN comes in second, at a higher cost with less surface temperature generated. Graphite is less efficient than TiN (lower amount of degrees Celsius generated per dollar), and gold is the least efficient of all three. Note that carbon
black was not directly simulated; however, it has similar properties and similar absorption spectra to graphite\textsuperscript{14}. We assumed the graphite simulation would also apply to Carbon black.

### Mass

![Varying mass TiN](image)

<table>
<thead>
<tr>
<th>Mass TiN</th>
<th>Surface Temperature</th>
</tr>
</thead>
<tbody>
<tr>
<td>.005 g</td>
<td>1.69</td>
</tr>
<tr>
<td>0.0314 g</td>
<td>7.07</td>
</tr>
<tr>
<td>.1 g</td>
<td>17.41</td>
</tr>
<tr>
<td>1 g</td>
<td>104.37</td>
</tr>
<tr>
<td>2 g</td>
<td>178.95</td>
</tr>
</tbody>
</table>

*Figure 27: Varying mass of TiN*

As seen in Figure 27, as the mass of TiN in the sample increases, the surface temperature increases.
Discussion

Interparticle Distance

A simulation was run to determine the effect of particle spacing on temperature change. A constant mass of TiN (.03139 g) in 10 mL of PMMA was used. The sample was 22 µm thick.

Code was modified so that the interparticle distance was manually set, instead of being calculated from the volume.

\[
volumePerParticle_{cmCubed} = \frac{1}{ParticlesPerCmCubed};
\]

\[
InterparticleDistance_{incm} = volumePerParticle_{cmCubed}^{(1/3)};
\]

\[
%InterparticleDistance_{innm} = InterparticleDistance_{incm}*10^7;
\]

%artificially set this

InterparticleDistance_{innm} = 4000;
Figure 28: Average Temperature Change vs Interparticle Distance

This had the effect seen in Figure 28, where the volume was unchanged, but the particle spacing varied.

Figure 29: Simulation of Variation in Particle Spacing with Constant Volume
Based on the pictures of the sample taken under the microscope the particles hadn’t dispersed well and were not evenly spaced (Figure 5, Figure 6). The simulation shows aggregation accounts for about 4 degrees of temperature change. This helps explain the slight discrepancy between experimental and simulated data in Figure 19.

Size Distribution

With a constant mass, a sample can either be many small particles, or a few big particles. This is depicted in Figure 30: Simulation of variation of particle size with constant mass.

![Figure 30: Simulation of variation of particle size with constant mass](image)

Both pictures have particles with the same total volume, but the picture on the left has the mass divided up into 9 small particles, and the picture on the right has the mass divided into 4 large particles.

As the size of the particle increases, the absorbance band shifts (Figure 16: Simulations of absorbance cross-section at varying particle radii for TiN. See Appendix B for the code.,
Figure 17: Simulations of absorbance cross section at varying particle sizes for Graphite. See Appendix B for the code.). This suggests that some particle sizes are more effective at generating heat than others, depending on how they align with the solar spectrum (Figure 3).

**Radius**

![Average temperature vs radius for TiN](image)

*Figure 31: Temperature change vs particle radius*

As seen in Figure 31, increase in particle radius size with constant mass results in an increase in temperature up to 900 nm radius particles. Particles with a radius greater than 900 nm result in a decrease in temperature.
Figure 32: Temperature increase throughout sample with a varying radius of TiN

Figure 32 shows the temperature curve through the distance of the sample with varying radii of TiN. Smaller radius particles have a higher surface temperature, but the temperature falls off faster as the distance through the sample increases. Particles with a larger radius have a lower surface temperature, but the temperature does not fall off as quickly with distance, leading to a slightly higher overall temperature.

Thickness
As seen in Figure 33, temperature generated decreases exponentially as the thickness of the sample increases. This happens because, with a constant volume, the surface area of the sample decreases as the thickness increases. A higher surface area means more nanoparticles get a higher intensity of light; the light that hasn’t been absorbed by particles above them. Sample thickness has a much higher impact on temperature generated than particle size, spacing, or mass.

**Conclusion**

We determined the optimal design of a thin film with embedded nanoparticles to achieve maximum heat generation. The optimal sample would consist of carbon black nanoparticles with a radius of 900 nm, packed closely together (1800 nm apart). It would be in a medium such as

![Figure 33: Temperature generated vs thickness](image)
aerogel with low thermal conductivity. The sample would have a maximum mass carbon black
with a minimal thickness of the sample.

**Future Work**

The next step is to use the optimized parameters to build a physical sample. This
optimized solar thermal device will help provide renewable energy with a high efficiency and
low cost. This cheap and effective source of renewable energy could then be used to slow the
rate of human contributions to global warming. This would have numerous economic and social
impacts. For example, it would reduce energy costs, and reduce the costs associated with fixing
infrastructure damage due to extreme weather events whose intensity is increased by global
warming. Additionally, Diseases such as malaria which spread more easily in warmer climates
would spread more slowly. Crop yields, which could plummet if critically high temperatures
were reached, would remain as they currently are.

Another area of future work is that of heat-generating nanomaterials for cold climate use.
The data gathered in this study could be used to design a cost-effective and efficient fabric that
generates heat in sunlight. This fabric could be used for space exploration as well as exploration
in cold climates such as Antarctica.
Works Cited


(7) Stanford University.; Center for the Study of Language and Information (U.S.). Stanford


(11) Solar Spectral Irradiance: ASTM G-173


